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Physics 120
Lab 1:  Basic Structure of VPython Programs for Physics Simulations
The advancement of scientific knowledge in the 21st century, especially in physics, includes modeling the behavior of nature and phenomena with computer programs.  With the development of fast and powerful computers, this approach to testing theories as well to enhance interpretations of experiments has grown into a mainstream form of scientific research.  We will, therefore, devote a few labs in this course on providing some experience in this type of work, and demonstrating how it can be effective.
We will use a free-downloadable, easy-to-install, and easy-to-use programming package called VPython.  This is a programming language in which it is easy to make 3-D graphics and animations. We will first learn the very basics of how to get going in this package, then create 3-D objects and then we will use it demonstrate vectors and vector operations in 3-D. 
For success in computer programming, it is essential to understand the basic concept of how a program tells the computer what to do, and how a computer “thinks.”  A computer program consists of a sequence of instructions that the computer carries out, precisely and literally, one-by-one, in the order in which they appear, and stops when it reaches the end.  Each instruction must be entered exactly correctly (as if it were an instruction to your calculator).  If the computer encounters an error in an instruction (such as a typing error), it will stop and print a red error message.

On the menu bar of the computer there should be a snake icon called “IDLE for Python” (if not, ask your instructor where to find IDLE). Click the IDLE icon. This starts IDLE, which is the editing environment for VPython.  NOTE:  when needing to edit an existing program, you must right-click and select “Edit with IDLE”.  Double clicking on the icon will run the program but will not enable you to edit the code.
1. Starting a program

Enter the following line of code in the IDLE editor window.

from visual import *

Every VPython program begins with this line. This line tells the program to use the 3D module (called “visual”).

Before we write any more, let’s save the program:  In the IDLE editor, from the “File” menu, select “Save.” Save the file in an appropriate place (such as a folder with your name), and give it the name “vectors.py”. YOU MUST TYPE the “.py” file extension.

2. Creating an object
Let’s tell VPython to make a sphere. On the next line, type:

sphere()

A line like this tells the computer to create an object, in this case, a sphere. Run the program by pressing F5 on the keyboard. Two new windows appear in addition to the editing window. One of them is the 3-D graphics window, which now contains a sphere.
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Running the program

Press F5.  You should see a sphere appear in the graphics window.
4. The 3-D graphics scene

By default the sphere is at the center of the scene, and the “camera” (that is, your point of view) is looking directly at the center.  Hold down the right mouse button and move the mouse around to make the camera “revolve” around the scene.  To zoom in and out, if on Windows, hold down both mouse buttons and move the mouse back and forth; if on a Mac hold the Alt key and move one finger on the touch pad.
5. The Python Shell window
The second new window that opened when you ran the program is the Python Shell window. If you include lines in the program that tell the computer to print text or values, they will appear in this window.  

a.  Use the mouse to make the Python Shell window smaller, and move it to the lower part of the screen. Keep it open when you are writing and running programs so you can easily spot error messages, which appear in this window. 

b.  Make your edit window small enough that you can see both the edit window and the Python Shell window at all times.  Do not expand the edit window to fill the whole screen. You will lose important information if you do!  To kill the program, close the graphics window. Do not close the Python Shell window
	
	


To see an example of an error message, let’s try making a spelling mistake.  Change the first line of the program to the following:

from bisual import *

Run the program (by pressing F5).  Notice that you get a message in red text in the Python Shell window. The message gives the filename, the line where the error occurred, and a description of the error (in this case “ImportError: No module named bisual”).  Correct the error in the first line.
Whenever your program fails to run properly, look for a red error message in the Python Shell window.  Even if you don’t understand the error message, it is important to be able to see it, in order to find out that there is an error in your code. This helps you distinguish between a typing (or coding) error and a program that runs but does something other than what you intended.

5. Attributes

Objects have attributes.  Let’s give the sphere a different position in space and a radius.   Change the last line of the program to 

sphere(pos=vector(-5,2,-3), radius=0.40, color=color.red)

Run the program.  The sphere-creation statement gives the sphere object three “attributes”:

1.) pos: the position vector of the center of the sphere, relative to the origin at the center of the screen

2.) radius
3.) color:   written as “color.xxx”, where xxx can be red, blue, green, cyan, magenta, yellow, orange, black, or white. 

Change the last line to read as follows and run the progrm again.
sphere(pos=vector(2,4,0), radius=0.20, color=color.white)

Note the changes in the sphere’s position, radius, and color.  Feel free to experiment with different values for the attributes of the sphere. When you are done, reset the line to how it appears above (that is, pos=vector(2,4,0), and radius=0.20).

6. Autoscaling and units

VPython automatically “zooms” the camera in or out so that all objects appear in the window. Because of this “autoscaling”, the numbers for the “pos” and “radius” could be in any consistent set of units, like meters, centimeters, inches, etc. For example, this could represent a sphere with a radius 0.20 m and a position vector of < 2, 4, 0 > m. In this course we will always use SI units in our programs (“Systeme International”, the system of units based on meters, kilograms, and seconds) and so most distances here will be m. 
7. Creating a second object
Type the following on a new line, then run the program:

sphere(pos=vector(-3,-1,0), radius=0.15, color=color.green)

You should now see the original white sphere and a new green sphere. In later exercises, these sphere will represent different objects.
8. Arrows

We will often use arrow objects in VPython to depict vector quantities.  Type the following on a new line, then run the program.
arrow(pos=vector(2,-3,0), axis=vector(3,4,0), color=color.cyan)

This line tells VPython to create an arrow object with 3 attributes:

1.) pos: the position vector of the tail of the arrow. In this case, the tail of the arrow is at the position < 2, -3 , 0 > m. 

2.) axis: the components of the arrow vector; measured from the tail to the tip. In this case, the arrow vector is < 3, 4, 0 > m.

3.)  color.

To demonstrate the difference between “pos” and “axis,” let’s make a second arrow with a different “pos” but same “axis.”  Type the following on a new line, then run the program.
arrow(pos=vector(3,2,0), axis=vector(3,4,0), color=color.red)

Note the red arrow starts at a different point than the cyan arrow, but has the same magnitude and direction. This is because they have the same “axis,” but different values of “pos.”  
Question:  What position would you give a sphere so that it would appear at the tip of the red arrow?

Discuss this with your partner(s).  Then, check with your instructor.

9. Scaling an arrow’s axis

Since the axis of an arrow is a vector, we can perform scalar multiplication on it.   Modify the axis of the red arrow by changing the last line of the program to the following:

arrow(pos=vector(3,2,0), axis=-0.5*vector(3,4,0), color=color.red)

Run the program. The axis of the red arrow is now equal to 0.5 times the axis of the cyan arrow. Note that the red arrow now points in the opposite direction of the cyan arrow – why?  Remember that multiplying a vector by a scalar changes the length of the arrow, but not its starting point.

10. Comments (lines ignored by the computer)

For the following, we will only need one arrow. Rather than deleting the line, we can make VPython ignore one of the “arrow” lines.  Add # to the beginning of the line in which we defined the cyan arrow, so that it looks like the following and run the program.
#arrow(pos=vector(2,-3,0), axis=vector(3,4,0), color=color.cyan)

The ”#” sign tells VPython that anything after it is “a comment,” and  not actual instructions.  Comments are skipped when the program runs.  You should get in the habit of using lots of comments to explain what all variables are and/or what the subsequent lines do.  It is far too common a problem that programmers use too few comment lines and then others trying to add on or improve the program get frustrated trying to figure out the structure of the program without any guidance.  A lot of unecessary time is wasted deciphering the previous programmer’s work.  Additionally, the original programmers themselves often return to the program after a fair bit of time and can’t remember what each variable was supposed to represent.  These problems are easily avoided by extensive use of comment lines:  explain all variables, and at the start of any loop to explain what the loop is for.

So, in your Vpython programs for this class, I want to see lots of comments.

The comment symbol (#) is also extremely useful for turning off some lines without deleting them from the program for good.  Your program, right now, for example, contains code for two arrows, but when you run it, only one arrow appears.  If you want to get the second arrow back, you can simply remove the #.

Take some time, now, to add comment lines to your program.  Put a comment line near the top that lists your name (as the author) and give your program a title and date.  As you develop the program further, following the instructions below, add comment lines before any line or group of lines that might not be clear what they are.
11. Position vectors

We can use arrows to represent position vectors and relative position vectors. Remember that a relative position vector that starts at  position 
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.  We now want to make an arrow to represent the relative position vector of the green sphere tennis relative to the white sphere.  That is, the arrow’s tail should be at the position of the white sphere, and the tip should be at the position of the green sphere.

Question:  What would be the “pos” of this arrow, whose tail is on the white sphere?
Question:  What would be the “axis” of this arrow, so that the tip is on green sphere?
Check your answers with your instructor before continuing,

Using these values of “pos” and “axis”, change the last line of the program to make the red arrow point from the white sphere to the green sphere.  Add a comment line to explain what the arrow is supposed to do.  Run the program.  Examine the display carefully. If  the red arrow does not point from the white sphere to the green sphere, you need to fix your program.

12. Naming objects and using object attributes

Now change the position of the green sphere.  Let’s give it a z-component; change its definition to:

sphere(pos=vector(-3,-1,3.5), radius=0.15, color=color.green)

Run the program.  Note that the relative position arrow still points in its original direction.  What if we want this arrow to always point toward the green sphere no matter where the sphere is? To do this, we need to refer to the green sphere’s position symbolically.  But first, since there is more than one sphere and we need to tell them apart in the code, we need to give the objects names.  Give names to the spheres by changing the “sphere” lines of the program to the following:

baseball = sphere(pos=vector(2,4,0), radius=0.20, color=color.white)

tennisball = sphere(pos=vector(-3,-1,3.5), radius=0.15, color=color.green)

We can now use these names to refer to either sphere individually. Furthermore, we can specifically refer to the attributes of each object by writing, for example, “tennisball.pos” to refer to the tennis ball’s position attribute. To see how this works, do the following exercise.  Let’s also give a name to the arrow.  Edit the next to the last line of the program (the red arrow) to the following,:

bt = arrow(pos=vector(3,2,0), axis=-0.5*vector(3,4,0), color=color.red)

Since we can now write symbolic expressions for the “axis” and “pos” of the arrow “bt”. The expressions should use general attribute names in symbolic form, like “tennisball.pos”, not specific numerical vector values such as vector(-3,-1,0). This way, if the positions of the tennis ball is changed, the arrow will still point from the baseball to the tennis ball.  

Question:  In symbols (letters, not numbers), what should be the “pos” of the red arrow that points from the baseball to the tennis ball? Make sure that your expression doesn’t contain any numbers.
Question:  In symbols (letters, not numbers), what should be the “axis” of the red arrow that points from the baseball to the tennis ball? (Remember that a relative position vector that starts at position 
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.) HINT:  It is an expression (containing no numbers).
Check your answers with your instructor before continuing.  

Change the program so that the statement defining arrow bt uses these symbolic expressions after “pos=” and “axis=”. Run the program. Examine the 3D display closely to make sure that the red arrow still points from the baseball to the tennis ball. If it doesn’t, correct your program, still using no numbers.  Change the “pos” of the baseball to (-4, -2, 5). Change the “pos” of the tennis ball to (3, 1, -2). Run the program. Examine the 3D display closely to make sure that the red arrow still points from the baseball to the tennis ball. If it doesn’t, correct your program, still using no numbers.

CHECKPOINT 1: Wait for your instructor to check your programt.  You can read ahead while you’re waiting.

13. Creating a static model

Be sure you have saved your old program, vectors.py.  Start a new program by going to the “File” menu and selecting “New window.” Again, the first line to type in this new window is:

from visual import *

From the “File” menu, select “Save.” Browse to an appropriate location and save the file with the name “planets.py”. (Remember that YOU MUST TYPE the “.py” file extension).
You will now write a program that makes a visual involving the Sun and three planets. The distances are given in scientific notation -- in VPython, to write numbers in scientific notation, use the letter “e”; for example, the number 2×107 is written as 2e7.
Create spheres to represent the Sun and three of the inner planets --  Mercury, Venus, and Earth – using the following considerations:

1.  The distances from the Sun to each of the planets are given by the following


Mercury: 5.8×1010 m from the sun


Venus: 1.1×1011 m from the sun


Earth: 1.5×1011 m from the sun

2.  The inner planets all orbit the sun in roughly the same plane, so place them in the x-y plane. Place the Sun at the origin, Mercury at < 5.8×1010 , 0, 0 >, Venus at < –1.1×1011, 0, 0 >, and Earth at < 0, 1.5×1011,0>.

3.  If you use the real radii of the Sun and the planets in your model, they will be too small for you to see in the empty vastness of the Solar System! So use these values:


Radius of Sun: 7.0×109 m


Radius of Mercury: 4×109 m


Radius of Venus: 6.0×109 m


Radius of Earth: 6.4×109 m

The radius of the Sun in this program is ten times larger than the real radius, while the radii of the planets in this program are about 1000 times larger than the real radii.

Give names to the objects: Sun, Mercury, Venus, and Earth, so that you can refer to their attributes.  For fun, you can add the following in the definition of the Earth’s (inside the parantheses that follow “sphere” with a comma separating it from the other attributes).

material=materials.BlueMarble

Finally create two arrows using symbolic values for the “pos” and “axis” attributes (no numerical data):

1.) Create an arrow representing the relative position of Mercury with respect to the Earth. That is, the arrow’s tail should be on Earth, and the arrow’s tip should be on Mercury. Give the arrow a name, “a1”.

2.) Imagine that a space probe is on its way to Venus, and that it is currently halfway between Earth and Venus. Create a relative position vector that points from the Earth to the current position of the probe. Give the arrow a name, “a2”.

Remember: Do not use numerical data to specify the arrow attributes.

CHECKPOINT 2: Wait for your instructor to check your program -- read ahead while you wait.

14. Loops, counters, and print statements
A loop is an extremely useful programming tool.  A loop is a set of instructions in a program that are repeated over and over until some condition is met. There are several ways to create a loop, but here we will use the “while” statement  (“do” and “for” statements are two others that can be used to make loops).
To start, let’s make a loop to repeatedly add to a quantity and print out the current value of the quantity.  Add the following statement at the end of your planets program:

step = 0

A line like this before a loop is often needed.  One way of controlling how long a loop should continue is to use a counter, which will calculate how many times the loop has been completed and when the counter gets to a certain value the program will exit the loop.  Here, we set the variable called “step” and assign it the initial value of 0.  On the next line, type.

while step<100:
Press the “Enter” key.   Notice that the cursor is now indented on the next line. (If it’s not indented, check to see if you typed the colon at the end of the “while” line. If not, go back and add the colon, then press “Enter” again.)   The “while” statement tells the computer to repeat the following set of  instructions, on the indented lines, as long as the condition in the while statement is true. In this case, the loop will continue as long as the variable “step” is less than 100.  On the next (indented) line, type:


step = step+1

In algebra, “step = step+1” makes no sense, but in VPython as in most programming languages, the equals sign means something different than it does in algebra.  This is not an equation but an assignment statement. This line assigns the variable to the left of the “=”, i.e. “step,” a new value.  In this case, the new value is the current value of step plus 1.  The first time through the loop, step starts with the value 0 and then the computer adds 1 to it, changing its value to 1.  The next time through the loop, the computer again adds 1 to step, making step equal to 2, and so on: 3, 4, 5, ….98, 99, 100.

We can have the program tell us what it has calculated some value to equal.  This is often very helpful as we develop a program, as this enables us to see that the program is doing what we think it should do.  On the next line (still indented), type:


print step

The last four lines you have typed should now look like this:

step = 0

while step<100:


step = step+1


print step

Run the program.  In the text output window, you should see a list of numbers from 1 to 100 in increments of 1. The first number,1, is the value of step the first time the “print step” line is encountered, which occurs at the end of the first time through the loop. Before each execution of the loop, the computer compares the current value of step to 100, and if it is less than 100, it executes the loop again. After the 100th time, the value of step is now 100.  When the computer goes back to the “while” statement for the next repetition, it finds the statement “step<100” is now false, since 100 is not less than itself. Because the condition is false, the computer then jumps past the indented lines.

To add lines after the while loop, go to the end of the last line in the loop, hit “Enter” and then simply unindent by pressing the “Backspace” key.  Type the following on a new, unindented, line.
print "End of program, step=", step

In this print statement, all the characters between the double quotation marks will be repeated exactly, and the term not inside quote (“step”) has a value that the program will print, and the comma separates the two elements in the print statement. 

Now the last five lines in your program should look like this:

step = 0

while step<100:


step = step+1


print step

print "End of program, step=", step

Run the program.  You’ll now see the sequence of numbers printed, followed by the text “End of program., step=100” (the while loop ended because step had become equal to 100). The line that prints this text is not in the loop, so the text prints only once, after the loop is done executing. 
If your program seems to be working now, delete the “print step” line inside the while loop.  This line produces a lot of unnecessary output and so we don’t really want it.

15.  Modeling motion with VPython

This is one task that is accomplished using loops.  Every program that models the motion of physical objects has two main parts:


Before the loop: The first part of the program tells the computer to:


Create numerical values for constants we might need


Create 3D objects


Give them initial positions and momenta


The “while” loop:  The loop contains the lines that tell the program how to change the position of the objects over and over 


again, making them move on screen. These lines tell the computer:

We’ll now use the loop to make Mercury move.  It will move in a very unphysical way, but later you will learn how to program the actual motion of stars and planets.  Before the start of your while loop, insert this statement.
deltar = vector(1e9,0,0)

This defines a vector increment 
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 of the position of Mercury. We’ll continually add this small vector “displacement” to the position of Mercury, which will make it move across the screen. The variable deltar is a vector, just like Earth.pos or a1.axis, but it is purely calculational and there is no visible display such as a sphere or an arrow associated with deltar.  Inside your while loop (indented), insert this statement (assuming your sphere is named Mercury):

Mercury.pos = Mercury.pos+deltar

Remember that this is not an equation, but an assignment.  The new position  of Mercury will be set to equal the current position plus deltar.  

Run the program.  You should now see Mercury move across the screen. This occurs because you are continually updating its position by adding a small vector displacement to its current position everytime through the while loop. The planet may move quite fast, depending on how fast your computer is.  To slow your program down, add the following statement inside your while loop (indented).
rate(20)

This statement says, “Don’t do more than 20 loop iterations per second, even if the computer is fast enough to do more.” Since you’re taking 100 steps in your program, Mercury will now take 5 seconds to move across the screen.  

Make the arrow “a1” point from the Earth to Mercury at all times, while Mercury moves. Insert an appropriate statement into the while loop (indented) to update the arrow “a1” so that its tail remains on the Earth but its tip is always on Mercury.  DON’T CREATE ANY NEW ARROWS; just update the attributes of your existing arrow “a1”.   Your arrow now has a name ‘a1’ and you refer to an attribute of a1 by a1.attribute.  For example, if you want to change the color of a1 to white, you could say a1.color = white.  

Run the program.  If you see your arrow getting thicker, then your program is creating a new arrow every time through the loop.  You only want to change an attribute of the arrow.  Try again.
Let’s change the direction that Mercury moves.  Your Mercury has been moving to the right, in the +x direction.  Change deltar in such a way that Mercury moves up and to the right at a 45 degree angle to the horizontal. The tip of the arrow pointing from the Earth to Mercury must remain on Mercury during the motion.  

Add comments to your program!  Put in comments before the while loop to explain what the loop accomplishes.
CHECKPOINT 3: Wait for your instructor to check your program -- read ahead while you wait.

Time Steps
Loops are often used to calculate sums, and in this case the counter is a helpful way to control the while loop.  For most purposes in this class, though, we will use VPython to simulate motions that occur in time.  And so, it will be more natural to use a time step instead of acounter.  This will also enable us to keep track of and calculate the time duration for the motion.  Change the 4 lines involving “step” to the following 5 lines:
deltat = 0.01

t = 0

while t < 5:


t = t + deltat

print “time duration =”,t

Run the program.  Note that our while statement, now, says to run the while loop for 5 seconds.  And, each time through the program loop, we will increment the value of t by deltat AND update the position of Mercury. 
Programming help
There is an on-line reference manual for VPython. In the text editor (IDLE), on the Help menu choose “Visual”. The first link, “Reference manual”, gives detailed information on spheres, arrows, etc. In the text editor (IDLE), on the Help menu choose “Python Docs” to obtain detailed information on the Python programming language upon which VPython is based.  We will use only a small subset of Python’s extensive capabilities.

To learn about debugging Syntax Errors, you can watch “VPython Instructional Videos: A. Debugging Syntax Errors” at http://www.youtube.com/VPythonVideos,  which discusses common syntax errors produced by novice users of VPython.

Lab 1 Report:  Write a (very) short abstract stating, what you did (Basically, you completed an introductory tutorial on developing VPython codes.  You should mention in the abstract why this is relevant/interesting.)  Submit your abstract along with your two programs either by email or Nexus.  Be sure to list any partners that you worked with!
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